
Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 
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-

-
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Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Laura Pope

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Klurfeld "Meat or No Meat" 
Symposium 4/6/2018 Minneapolis, MN Air Transportation X $267.60 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $298.00 

National Program 
Leader, Human 
Nutrition,  ONP

University Of Minnesota, 
Department of Food 
Science and Nutrition 

4/6/2018 04/05/2018-4/7/2018 Meals X $59.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Marlen D. Eve Meeting with AgriTech 
Hub Kazakhstan. 4/21/2018 Almaty, Kazakhstan Air Transportation X $2,760.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $1,519.00 

Deputy Administrator, 
Natural Resources and 
Sustainable Agricultural 
Systems, ONP

Kazakh National Agrarian 
University 4/28/2018 04/20/2018-

04/28/2018 Meals X $594.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jeffrey Silverstein

United States-Israel 
Binational Agricultural 
Research and 
Development Fund 
(BARD) Technical 
Advisory Committee 
meeting

4/23/2018 Tel Aviv, Israel Lodging X $1,680.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $680.00 

Deputy Admistrator, 
Animal Production and 
Protection, ONP

United States-Israel 
Binational Agricultural 
Research and 
Development Fund 
(BARD) 

4/25/2018 04/21/2018-
04/26/2018                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - HQ/NAL/ONP

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

Laura.Pope@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

University of Minnesota

BENEFIT SOURCE

Kazakh National Agrarian 
University

BENEFIT SOURCE

United States-Israel 
Binational Agricultural 

Research and 
Development Fund 

(BARD)

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 2 2018

Agency Contact: Kit Mernick

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Shawn Bearson Mid-Atlantic Nutrition 
Conference 4/4/2018 Hunt Valley, MD Air Transportation                                     X $454 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging        X $340 

Research Microbiologist Phileo Lesaffre Animal 
Care 4/5/2018 04/03/2018-

04/06/2018 Meals          X $206 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Elizabeth Ainsworth St. Louis Climate Summit 4/24/2018 St. Louis, MO Lodging        X $260 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals                       X $54 

Research Molecular 
Biologist St. Louis University 4/24/2018 4/22/2018-4/24/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Lucy R. Stewart Seminar presentation and 
collaboration meeting 3/28/2018 Jeonju City, Jeollabuk-

do, Korea Lodging        X $395 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals        X $318 

RES Molecular 
Biologist

Rural Development 
Administration (RDA) of 
South Korea

4/2/2018 3/26/2018-4/07/2018                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - MWA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

kit.mernick@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Phileo Lesaffre Animal 
Care

BENEFIT SOURCE

St. Louis University

BENEFIT SOURCE

Rural Development 
Administration (RDA) of 

South Korea

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP
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                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2 2 2018

Agency Contact: Kit Mernick

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Doug Karlan
Intersection of Soil Health 
& Water Quality Modeling 
in Great Lakes

7/16/2018 Ann Arbor, MI airfare x 550

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] lodging x 200

Res Soil Scientist Cooperative Institute for 
Great Lakes Res (CIGLR) 7/18/2018 7/16/18 - 7/18/18 transportation x 150

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Paul South International Symposium 
on Synthetic Biology 8/7/2018 Shanghai, China airfare x 5465

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] lodging x 777

Res Molecular Biologist Shanghai Institutes for 
Biology Sciences 8/10/2018 8/6/18-8/10/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Siqing Liu
2nd International Conf on 
Advances in 
Biotechnology

7/23/2018 Kuala Lumpur, 
Malaysia Lodging x 450

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Res Molecular biologist Biotechnology Res 
Conference 7/25/2018 7/20/18-7/26/18                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - MWA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

kit.mernick@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Cooperative Institute for 
Great Lakes Res 

(CIGLR)

BENEFIT SOURCE

Shanghai Institute for 
Biology Sciences

BENEFIT SOURCE

Biotechnolgoy Res 
Conference

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 2018

Agency Contact: Marita Rosati

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jenni Firrman
Presentations at Huaqiao 
University and Zhejiang 
University

4/2/2018 Hangzhou, China Air, Lodging

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Total Paid to 
Agency X $2,600.00 

Research Molecular 
Biologist

Huaqiao University and 
Zhejiang University 4/14/2018 4/2/18 - 4/12/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kathy Soder

National SARE 
(Sustainable Agriculture 
Research & Education) 
Conference - Our Farms, 
Our Future

4/3/2018 St. Louis, MO Total In-Kind X $1,450.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Animal Scientist National SARE 4/5/2018 4/2/18 - 4/6/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kerry Pedley US Soybean Symposium 
(SoySym) 4/4/2018 Columbia, MO

Lodging, Meals, 
Parking, Travel, 
Shuttle, etc.

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $965.00 

Research Molecular 
Biologist Missouri Soybean Center 4/4/2018 4/3/18 - 4/5/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

Huaqiao University and 
Zhejiang University

BENEFIT SOURCE

Northeast SARE

BENEFIT SOURCE

Missouri Soybean Center

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

marita.rosati@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - NEA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Joanne Labate

Annual meeting for the 
CucCAP project:  
"CucCAP:  Leveraging 
applied genomics to 
increase disease 
resistance in Cucurbit 
crops."

4/4/2018 Raleigh, NC Air, Lodging, 
Meals

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Total Paid to 
Agency X $777.00 

Molecular Biologist CucCAP 4/5/2018 4/3/18 - 4/5/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Shelley Jansky
Bioagricultural Sciences 
and Pest Management 
(BSP) Seminar Series

4/11/2018 Fort Collins, CO Lodging, Air, 
Meals, Taxi

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $501.50 

Research Geneticist Colorado State University 4/11/2018 4/10/18 - 4/12/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Douglas Luster
Borlaug Global Rust 
Initiative (BGRI) Technical 
Workshop

4/14/2018 Marrakesh, Morocco Air, Lodging, 
Meals

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,450.00 

Research Plant 
Physiologist

Borlaug Global Rust 
Initiative, International 
Organizing Committee

4/17/2018 4/13/18 - 4/18/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Sevim Erhan
9th Annual Congress and 
Expo on Biofuels and 
Bioenergy

4/16/2018 Dubai, United Arab 
Emirates Lodging

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $600.00 

Center Director Biofuels Conference 2018 4/17/2018 4/13/18 - 4/18/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Brian Peterson Department of Animal 
Science Seminar Series 4/19/2018 University Park, PA

Air, Lodging, 
Meals, Parking, 
Transportation

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $650.00 

CucCAP

BENEFIT SOURCE

Colorado State University

BENEFIT SOURCE

Borlaug Global Rust 
Initiative, International 
Organizing Committee

BENEFIT SOURCE

Biofuels Conference 
2018

BENEFIT SOURCE

The Pennsylvania State 
Unversity, Department of 

Animal Science

LOCATION

TRAVEL DATE(S)

TRAVEL DATE(S)

5

6

LOCATION

TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)

8

LOCATION

TRAVEL DATE(S)

4

7



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Research Physiologist
The Pennsylvania State 
University, Department of 
Animal Science

4/19/2018 4/18/18 - 4/20/18 Total Paid to 
Agency X $100.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Michael Havey Genebank Training 
Workshop 4/24/2018 Fort Collins, CO Ai, Lodging, 

Shuttle

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $965.61 

Research Geneticist 
(Plants) Colorado State University 4/26/2018 4/23/18 - 4/26/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Stanley
Spring Conference of the 
Korean Society of Applied 
Entomologists

4/24/2018 Mokpo, Korea Air, Lodging, 
Meals, Taxi

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,500.00 

Research Entomologist Korean Society of Applied 
Entomology 4/28/2018 4/23/18 - 4/28/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Tracy Leskey
2018 Spring Conference 
of the Korean Society of 
Applied Entomology

4/25/2018 Mokpo, Korea
Air, Lodging, 
Meals, Parking, 
Taxi, etc.

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,006.00 

Research Entomologist Korean Society of Applied 
Entomology 4/27/2018 4/20/18 - 4/30/18 Total Paid to 

Agency X $3,120.47 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Doug Allen

Department of 
Biochemistry and 
Molecular Biophysics 
Seminar

4/26/2018 Manhattan, KS Lodging, Rental 
Car

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $288.00 

Research 
Computational Biologist Kansas State University 4/26/2018 4/25/18 - 4/27/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Amy Tabb Seminar Presentation 5/16/2018 St. Louis, MO
Air, Lodging, 
Meals, Taxi, 
Parking, etc.

BENEFIT SOURCE

Colorado State University

BENEFIT SOURCE

Korean Society of 
Applied Entomology

BENEFIT SOURCE

Korean Society of 
Applied Entomology

BENEFIT SOURCE

Kansas State University

BENEFIT SOURCE

Donald Danforth Plant 
Science Center

TRAVEL DATE(S)

11

LOCATION

TRAVEL DATE(S)

12

LOCATION

TRAVEL DATE(S)

13

LOCATION

9

LOCATION

TRAVEL DATE(S)

10

LOCATION



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $560.00 

Research Agricultural 
Engineer

Donald Danforth Plant 
Science Center 5/16/2018 5/15/18 - 5/17/18 Total Paid to 

Agency X $367.20 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Michael Wisniewski

Presentations at 
Chongquing University 
and China Agricultural 
University

5/21/2018
Chongqing, China, 
Beijing, China and 
Yantai, China

Air, Lodging, Taxi

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,926.00 

Research Plant 
Physiologist

Chongqing University of 
Arts and Sciences 5/31/2018 5/20/18 - 6/1/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Geoffrey Zanton
Reexamining Amino Acid 
& Energy Interactions in 
the Dairy Cow

5/29/2018 Itasca, IL Lodging, 
Registration

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $902.25 

Research Animal 
Scientist

American Dairy Science 
Association 6/1/2018 5/29/18 - 6/1/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Philipp Simon
International Symposium 
on Carrot and Other 
Apiaceae

9/19/2018 Krakow, Poland Air, Lodging, 
Registration, Taxi

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,733.00 

Research Geneticist 
Plants

University of Agriculture in 
Krakow 9/28/2018 9/16/18 - 9/26/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Mel Oliver

FEBS Workshop 2018 - 
Resurrection plants:  
Hope for crop drought 
tolerance (ReHOPE)

9/20/2018 Plovdiv, Bulgaria Air, Lodging, 
Meals

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,068.00 

Research Geneticist
Institute of Molecular 
Biology and 
Biotechnologies

9/22/2018 9/18/18 - 9/23/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE

University of Agriculture 
in Krakow

BENEFIT SOURCE

Institute of Molecular 
Biology and 

Biotechnologies

BENEFIT SOURCE

BENEFIT SOURCE

American Dairy Science 
Association

BENEFIT SOURCE

Chongqing University of 
Arts and Sciences

TRAVEL DATE(S)
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LOCATION

TRAVEL DATE(S)

15

LOCATION

16

LOCATION

TRAVEL DATE(S)

17

LOCATION

TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Tamie Veith Presentation Annis Water 
Resources Institute 4/9/2018 Muskegon, MI

Air, Lodging, 
Meals, Parking, 
Taxi, etc.

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $636.00 

Agricultural Engineer Annis Water Resources 
Institute 4/12/2018 4/9/18 - 4/12/18 Total Paid to 

Agency X $296.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Beth Cleveland Pacific Seafoods Annual 
Aquaculture Meeting 4/16/2018 Shelton, WA Air, Lodging, 

Rental Car

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $1,708.00 

Growth Physiologist Pacific Aquaculture 4/17/2018 4/15/18 - 4/18/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

John Norelli Meeting - Conservation of 
Malus Sieversii 5/2/2018 Almaty, Kazakhstan Air, Lodging

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $4,470.00 

Research Plant 
Pathologist

International Fund of 
Preservation the Malus 
Sierversii

5/8/2018 4/29/18 - 5/9/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

John Norelli
JKI Colloquium on Recent 
Developments in Fruit 
Breeding and Genetics

5/17/2018 Dresden, Germany Air, Lodging

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,727.00 

Research Plant 
Pathologist Julius Kuhn-Institut (JKI) 5/17/2018 5/14/18 - 5/21/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Steven Lehotay 12th European Pesticide 
Residue Workshop 5/21/2018 Munich, Germany Air, Lodging, 

Meals, Taxi

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $2,150.00 

Research Chemist
Organizers of the 
European Pesticide 
Residue Workshop

5/25/2018 5/19/18 - 5/26/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT SOURCE
International Fund of 

Preservation the Malus 
Sieversii

BENEFIT SOURCE

Julius Kuhn-Institut (JKI)

BENEFIT SOURCE
Organizers of the 

European Pesticide 
Residue Workshop

BENEFIT SOURCE

Annis Water Resources 
Institute

BENEFIT SOURCE

Pacific Aquaculture

TRAVEL DATE(S)
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LOCATION
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MM/DD/YYYY]:
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DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Joshua Gurtler
International Association 
for Food Protection 107th 
Annual Meeting

7/8/2018 Salt Lake City, UT Air, Lodging, 
Registration 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Total In-Kind X $1.175.00

Research Food 
Technologist

International Association 
for Food Protection 7/11/2018 7/7/18 - 7/12/18                            

International Association 
for Food Protection

TRAVEL DATE(S)

23



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-326 
(in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 CFR 
§304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and holding 
the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are finished and 
the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print area. 
When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Tracy Kita

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Scott Adkins Department of Plant 
Pathology Seminar 4/30/2018 Columbus, Ohio Hotel x $200 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation x $500 

Research Plant 
Pathologist Ohio State University 5/1/2018 04/29/2018 - 

05/01/2018 Meals x $150 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Claudio Afonso Hipra University 
Symposium 7/25/2018 Kuala Lumpur 

Malaysia Hotel x $1,200 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $600 

Research Microbiologist University Putra Malaysia 7/26/2018 07/22/2018 - 
07/27/2018 Meals x $200 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Claudio Afonso Hipra University 
Symposium 5/10/2018 Lima, Peru Hotel X $400 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $1,200 

Rearch Microbiologist University of San Marco 5/11/2018 05/09/2018 - 
05/12/2018 Meals X $200 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - NEA/SEA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: Apr 1, 
2018 - Sep 30, 

2018

REPORTING 
PERIOD: Apr 1, 
2018 - Sep 30, 

2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

tracy.kita@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Ohio State University

BENEFIT SOURCE

University Putra Malaysia

BENEFIT SOURCE

Laboratorios Hipra

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Karen Hughes

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Taylor NW Pacific Dairy Seminar 4/3/2018 Sunnyside, 
Washington Hotel X $200 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $400 

Res Entomologist Champion Animal Health 4/3/2018 4/2/2018-4/4/2018 Meals X $200 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kristin Hales
2018 Plains Nutrition 
Council Spring 
Conference

4/5/2018 San Antonio, TX Hotel X $248 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $458 

Res Animal Scientist SD State University 4/6/2018 4/4/2018-4/6/2018 Reg, Meals, 
Parking, Shuttle X X $284 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Timothy Smith Lecture 4/9/2018 Dublin, Ireland Hotel X $871.76 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $791.93 

Res Chemist British Soceity of Animal 
Science 4/11/2018 4/7/2018-4/13/2018 Reg, Meals, 

Shuttle X X $1,230 

BENEFIT SOURCE

Champion Animal Health

BENEFIT SOURCE

SD State University

BENEFIT SOURCE
British Society of Animal 

Science

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

Karen.Hughes@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - PA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Lisa Jackson-Beitia

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ellyn Bitume

International Congress of 
Biological Control: 
Biological Control for a 
Healthy Planet

5/14/2018 Beijing, China Lodging X $376.36 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Common Carrier X $800.00 

Research Entomologist - 
Post Doc Colorado State University 5/15/2018 5/12/2018 - 5/18/2018 Ground 

transportation X $200.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Eduardo Bautista Lecture 4/11/2018 Sacramento, CA Air Transportation         X $370.86 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging         X $146.00 

Research Hydraulic 
Engineer

California State University, 
Davis 4/12/2018 04/11/2018 - 

04/12/2018
Ground 
Transportation         X $50.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kevin Bronson 2018 4R Summit 6/11/2018 Des Moines, IA Air Transportation X $533.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $109.00 

Supervisory Research 
Soil Scientist Fertilizer Institute 6/12/2018 06/11/2018 - 

06/12/2018 Baggage X $50.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - PWA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

lisa.jacksonbeitia@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Colorado State University

BENEFIT SOURCE

California State 
University, Davis

BENEFIT SOURCE

Fertilizer Institute

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                  agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Cack Norquist

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Hamed Abbas

Departmental Seminar 
Series at the Dept. of 
Plant Pathology, Univ of 
Minnesota (4/2-3/18); Not 
covered by contributed 
funds - Present seminars 
to Dept of Medicinal 
Chemistry, College of 
Pharmacy (4/4-6/18)

4/2/2018 St. Paul, MN Air Transportation
Hotel

X
X

$600
$250

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X

X $100 

Research Plant 
Pathologist Univ. of Minnesota 4/3/2018 4/01/2018 - 4/7/2018 Ground 

Transportation
X
X $150 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Ann Donoghue Presentation at the 
Southern SARE Program 4/3/2018 Griffin, GA POV Mileage

Hotel
X
X

$128
$390

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $189 

Research Leader Southern SARE Program 4/5/2018 4/02/2018 - 
4/05/2018 Parking X $50 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Joan Burke Our Farms, Our Furture 
Conference 4/3/2018 St. Louis, MO Air Transportation 

Hotel X               X       $500     
$298

BENEFIT SOURCE

Univ. of Minnesota, Dept. 
of Plant Pathology

BENEFIT SOURCE

Southern SARE 
(Sustainable Agriculture 
Research & Education)

BENEFIT SOURCE

Southern SARE 
(Sustainable Agriculture 
Research & Education)

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

cack.norquist@ars.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Agricultural Research Service - SEA

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $175 

Resaerch Animal 
Scientist

Southern SARE 
Conference 4/5/2018 4/2/18-4/4/18 Registration fee 

Miscellanous
X                  
X

$250     
$100

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Henry Norcom

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jean Buzby Meeting - First Food Loss 
and Waste Expert Group 5/15/2018 Mexico City, Mexico Lodging, Meals 

and Airfare X 1077.6

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Chief, Diety, Safety and 
Health Economics 
Branch

Commission for 
Environmental 
Cooperation

5/16/2018 5/14 - 5/17/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Timothy Wojan

Conference - 11th OECD 
Rural Development 
Conference: Enhancing 
Rural Innovation

4/9/2018 Edinburgh, Scotland Airfare x 1159

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x 750

Sr. Economist
Organisation for 
Economic Cooperation 
and Development (OECD)

4/12/2018 4/7 - 4/13/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Timothy Wojan
Creative and Digital Rural 
Economy Research 
Seminar - presentation

4/12/2018 London, England Airfare X 112

BENEFIT SOURCE

Commission for 
Environmental 
Cooperation

BENEFIT SOURCE

Organisation for 
Economic Cooperation 

and Development 
(OECD)

BENEFIT SOURCE

Littoral Arts Trust

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

hnorcom@ers.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
Economic Research Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X 250

Sr. Economist Littoral Arts Trust 4/12/2018 4/12 - 4/13/2018                            

TRAVEL DATE(S)



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA Headquarters, 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Alan Ager Meeting and workshop 6/4/2018 Cordoba Argentina  transportation x 2500

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Research Forester

 Ministry of Science, 
Technology and 
Productive Innovation of 
Argentina

6/15/2018 6/7/2018-6/16/2018                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

DEVENDRA MAN 
AMATYA

Public Defense of a 
Doctoral Thesis 4/4/2018 Finland, Helsinki transportation x x 1650

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] hotel x 852

Research Hydrologist

Department of Civil and 
Environmental 
Engineering, Aalto 
University, Helsinki, 
Finland

4/6/2018 4/3/18-4/8/18 per diem x 615

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Michelle Baumflek
Fieldwork for an ongoing 
research project at Acadia 
National Park

7/5/2018 Acadia National Park per diem x 1589

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel x 3479

BENEFIT SOURCE
 Ministry of Science, 

Technology and 

BENEFIT SOURCE
Department of Civil and 

Environmental 
Engineering  Aalto 

BENEFIT SOURCE

Schoodic Institute at 
Acadia National Park

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FOREST SERVICE
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



 

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

Research Biologist Schoodic Institute at 
Acadia National Park 8/3/2018 7/2/18-8/5/18 transportation x 2712



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA, Headquarters 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Susan M. Stein
Southern Region SARE 
Summer Administrative 
Council Meeting

8/6/2018 Savannah, GA

Common Carrier   
Taxi/Shuttle        
Travel Fee           
Voucher Fee

x                 x                 
x                 x

$472.00     
$120.00     
$8.26         
$14.75

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Lodging              
Hotel Taxes        
Baggage

x                 x                 
x

$351.00     
$63.63       
$50.00

Director, National 
Agroforestry Center University of Georgia 8/8/2018 8/5/18-8/8/18 Per Diem (at gov 

rate) x $206.50 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Coeli M. Hoover
RREA E-Learning for 
Forest Carbon 
Management Workshop

8/21/2018 Ypsilanti,  MI
Lodging              
Common Carrier  
Meals

x                x                 
x

$378.00     
$300.00     
$75.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $150.00 

Research Ecologist Michigan State University 8/22/2018 8/20/18-8/22/18 Per Diem (at gov 
rate) x $88.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jennifer Hayes Cool Forests at 
Risk/IBFRA18 9/17/2018 Vienna, Austria Common Carrier   x $1,175.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,050.00 

Public Affairs Specialist International Institute for 
Applied Systems 9/20/2018 9/17/18-9/23/18                            

BENEFIT SOURCE

University of Georgia

BENEFIT SOURCE

Michigan State University

BENEFIT SOURCE
International Institute for 

Applied Systems 
Analysis

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 Andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

FOREST SERVICE  1353 TRAVEL REPORT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA, Headquarters 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jerry L. Hatfaield Editor's Conference for Tri-
Society Journals 6/25/2018 Madison, WI Per Diem (at Gov 

Rate) x $147.50 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $324.00 

Supvy. Plant 
Physiologist

American Society of 
Agronomy 6/26/2018 6/24/18-6/26/18 Mileage              

Parking x                 x $354.25      
$40.00

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Edward S. Buckler, IV
Emerging Technologies 
for Global Food Security 
Conference

6/19/2018 Saskatoon, Canada Common Carrier x $817.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $360.00 

Research Geneticist Global Institute for Food 
Security 6/21/2018 6/18/18-6/22/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Roger Wise
International Cereal Rusts 
and Powdery Mildews 
Conference

9/20/2018 Skukuza, South 
Africa

Lodging              
Meals                 
Taxi/Shuttle

x                  
x                 x

$840.00    
$632.00    
$100.00

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Airport Parking    
Registration x                 x $48.00      

$550.00
Research Geneticist Iowa State University 9/26/2018 9/20/18-9/27/18 Common Carrier x $1,700.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

HEADQUARTERS  1353 TRAVEL REPORT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 Andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

American Society of 
Agronomy

BENEFIT SOURCE

Global Institute for Food 
Security

BENEFIT SOURCE

Iowa State University

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA, Headquarters 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Antoinette J. Piaggio Wihelminenberg Seminar 
Talk 6/20/2018 Austria Common Carrier x $400.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging x $1,250.00 

Project 
Leader/Research 
Scientist

Dept. of Integrative 
Biology & Evolution, 
Konrad Lorenz Institute of 
Ethology

6/20/2018 6/16/18-6/23/18 Taxi/Shuttle x $200.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Dr. Lisa Marie Mia Kim 
Torchetti

10th International 
Symposium on Avian 
Influenza

4/15/2018 United Kingdom Common Carrier x $1,400.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging & Meals x $1,773.00 

Section Head DLV-
Avian

United Kingdom Animal 
and Plant Health Agency 4/18/2018 4/13/18-4/19/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Barney P. Caton Centre for Excellence in 
Biosecurity Risk Analysis 4/23/2018 Australia Lodging x $1,200.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Hotel Taxes x $120.00 

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

MARKETING 1353 TRAVEL REPORT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 Andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Dept. of Integrative 
Biology & Evolution, 

Konrad Loreenz Institute 

BENEFIT SOURCE

United Kingdom Animal 
and Plant Health Agency

BENEFIT SOURCE

Centre for Excellence in 
Iosecurity Risk Analysis

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 Pest Exclusion Analysis 
Coordinator

Centre for Excellence in 
Biosecurity Risk Analysis 4/27/2018 4/20/18-4/28/18 Common Carrier  

Meals
x                 
x

$2,000.00   
$175.00



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2018

Agency Contact: Leigh Zarbough

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Claire Boryan

“Earth Observation 
Technologies for Crop 
Monitoring - A Workshop 
to Promote Collaborations 
among 
GEOGLAM/JECAM/Asia-
RiCE 2018” 

8/17/2018 Taichung, Taiwan Lodging x 569.56

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare x 1528.11

Geographer Taiwan Agricultural 
Research Institution 8/21/2018 8/15 - 8/22/2018 Perdiem, Taxi, 

Traini x 464.83

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Zhengwei Yang

“Earth Observation 
Technologies for Crop 
Monitoring - A Workshop 
to Promote Collaborations 
among 
GEOGLAM/JECAM/Asia-
RiCE 2018” 

8/17/2018 Taichung, Taiwan Lodging x 569.56

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare x 1528.11

Agricultural Statistician Taiwan Agricultural 
Research Institution 8/21/2018 8/15 - 8/22/2018 Perdiem, Taxi, 

Traini x 464.83

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

U.S. Department of Agriculture
National Agricultural Statistics Service

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

LOCATION

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

leigh.zarbough@nass.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Taiwan Agricultural 
Research Institution

BENEFIT SOURCE

Taiwan Agricultural 
Research Institution

BENEFIT SOURCE

BENEFIT SOURCE



BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

TRAVELER 

No.

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

 
Benjamin Reist

Workshop - 
Implementation of 
Response Survey Design

6/27/2018 Ann Arbor, MI

Lodging, airfare, 
lodging, taxi, 
shuttle, POV, 
baggage fees

X 868.94

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Deputy Director for 
Science and Planning

Univ. of Michigan, Inst. for 
Social Research 6/27/2018 6/26 - 6/27/2018                            

3

TRAVEL DATE(S)

Univ. of Michigan, Inst. 
for Social Research



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
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                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA, Headquarters 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Zamir Libohova
Workshop on Spatial 
predictions of dynamic soil 
properties

5/2/2018 Switzerland Lodging x $240.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $45.00 

Research Soil Scientist Agroscope Institute for 
Plant Production Sciences 5/3/2018 5/218-5/4/18 Per Diem (at gov 

rate) x $130.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Zamir Libohova
2nd. International 
Conference on Agriculture 
and Life Sciences

5/7/2018 Tirane, Albania Lodging x $560.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

Taxi/Shuttle         
Registration

x                 
x

$80.00      
$130.00

Research Soil Scientist Agricultural University of 
Tirana 5/9/2018 5/4/18-5/11/18 Meals x $20.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Shelby Calaway Diverse Academic 
Careers Workshop 4/16/2018 Lawrence, Kansas Common Carrier x $350.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Taxi/Shuttle x $50.00 

Historian University of Kansas 4/16/2018 4/16/18-4/17/18 Lodging x $150.00 

BENEFIT SOURCE

Agroscope Institute for 
Plant Production 

Sciences

BENEFIT SOURCE

Agricultural University of 
Tirana

BENEFIT SOURCE

University of Kansas

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 Andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

NRCS  1353 TRAVEL REPORT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right click, 
select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" checkbox 
at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left click the name of 
an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  Select "OK".  A new 
sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that each 
tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent possible, 
agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All submissions must be 
made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still submit 
a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or the SF-
326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-colored 
cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected so that you 
can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages refer to 
the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of the 
spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell to the 
left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-agencies: 
Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the Department ABC 
worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's position in the 
workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The Department XYZ report 
would read 2 for Page-- referring to its order as the second report-- and 2 for Of Pages-- referring to the total 
number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the excel 
file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency Name], 
[Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate information. If 
there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option to 
"Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the upper 
right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over the 
cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will remain 
highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see how the 
file will look when it is printed.

Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC
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NARA
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NTSB
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OSHRC
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ONDCP
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OSTP
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                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2018

Agency Contact: USDA, Headquarters 
Office of Ethics

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Eddie Smith
Virginia Rural Water 
Association Annual 
Conference 

4/16/2018 Roanoke, VA Conference 
Registration x $215.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

State Engineer Virginia Rural Water 
Association 4/18/2018 4/16/18-4/18/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert B. Hilt
Virginia Rural Water 
Association Annual 
Conference

4/16/2018 Roanoke, VA Conference 
Registration x $215.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Area Specialist Virginia Rural Water 
Association 4/18/2018 4/16/18-4/18/18                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Cynthia Hines
Virginia Rural Water 
Association Annual 
Conference

4/16/2018 Roanoke, VA Conference 
Registration x $300.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Community Program 
Specialist

Virginia Rural Water 
Association 4/18/2018 4/16/18-4/18/18                            

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

RURAL DEVELOPMENT 1353 TRAVEL REPORT
NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2017- MARCH 

31, 2018

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2018

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 Andrew.tobin@oe.usda.gov

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

Virginia Rural Water 
Association

BENEFIT SOURCE

Virginia Rural Water 
Association

BENEFIT SOURCE

Virginia Rural Water 
Association

BENEFIT SOURCE
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